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System Preferences
When System Preferences is first launched, you will see rows of icons, each corresponding to a specific group of related options. Click on any icon
to access the relevant pane. Alternatively, you can access a pane if you click-hold, Ctrl-click or right-click on the System Preferences Dock icon
to access the contextual menu.

Search in System Preferences If you’re not sure exactly what you’re looking for, use the built-in search in the top right corner. Click in the search
field (or press Cmd+F) and start typing. As you type, the number of subjects in the results list will be filtered to match your search term, and
spotlights will appear, highlighting potentially relevant panes that might offer what you require
System Preferences in Alphabetical order You can reorder the panes by using the View menu, which provides options for organizing panes by
category or listing everything alphabetically. To sort alphabetically, go to the View menu and select Organize Alphabetically.
Hiding a System Preference Pane When you select View > Customize, checkboxes appear next to each pane. Deselect any pane’s checkbox and
click Done and the pane will be hidden, but it will remain accessible from the View menu and when performing searches.
How Do I Remove a Third-Party preference pane? A third-party System Preferences pane can be removed either by the pane’s own uninstaller (if
it has one) or by Ctrl/right-clicking it and selecting Remove <Preference Pane Name>
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General
The first System Preference Pane, General, pertains to appearance, scroll bars, document behavior and the number of recent items shown in
the Apple Menu.

Appearance: Light

Appearance: Dark

Appearance Determines the button, menu and window theme for macOS, enabling you to switch between Light and Dark. Dark Mode darkens
the color scheme so the content you’re working on stands out while windows and controls seem to recede into the background.
Accent color Choose the color to use for buttons, pop-up menus, and other UI controls.
Highlight color This enables you to change the color of highlighted content such as selected text in documents. Apple provides a list of colors
you can choose from, but you can define your own by selecting Other and using the standard macOS color picker.
Sidebar icon size This gives you alternate options for the size of icons in Finder’s sidebar. Medium is the default, Large is good if you find it
hard to click the existing icons, and Small is the best choice if you’ve a small display. Note that the setting you define here also may affect
other apps’ sidebar
Automatically hide and show the menu bar When active, this option hides the menu bar unless the cursor is at the top of the screen.
Show Scroll Bars You can adjust how scroll bars in macOS behave. By default, they are not visible, but show automatically when you move your
mouse or trackpad over them. You can adjust this so that they only show when scrolling regardless of the input device or always show when
content is too big for the viewport.
Click in the scroll bar to This setting changes how macOS jumps to content when you click inside a scroll bar. With Jump to the next page
selected, content jumps in screen-heights or pages, in the direction of your click; with Jump to the spot that’s clicked, it instead jumps to the
point in the document relative to the location clicked on the scroll bar.
The Default web browser You can define whether Safari or another browser should launch when you click a link in an email.
Ask to keep changes when closing documents By turning on this option, you get the choice regarding whether to save the changes or revert the
document to how it was when last opened.
Close windows when quitting an app When You have this unchecked, open documents should reappear as they were when you last closed an
application. Check this option and applications will launch without any open documents, unless they have their own built-in settings to override
macOS’s default behaviour.
Recent items This option defines how many items appear in the Recent Items menu in the Apple menu. By default, up to 10 of each type
(Applications, Documents, Server Volumes) are shown. Note that any setting chosen also affects recent-item Dock stacks.
Allow Handoff between this Mac and your iCloud devices If your Mac supports Handoff, select the checkbox to turn on Handoff between your
Mac, iOS devices, and Apple Watch set up with iCloud. When this option is selected, you can use Universal Clipboard to copy and paste between
your devices.
Use font smoothing when available Font smoothing reduces jagged edges for some fonts. When text smoothing (or “antialiasing”) is on, smaller
fonts may be harder to read.
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Desktop and Screen Saver
The Desktop & Screen Saver pane in System Preferences is where you adjust your desktop background image and/or the screen saver that kicks
in after a user-defined period of time.
Desktop Tab
You will see a thumbnail of the current background image, alongside which will be its title. On the sidebar, you can select collections of images.
By default, you’ll see two under the collapsible Apple list (Desktop Pictures and Colors) and your Photos albums appear under relevant headings.
The next item is a collapsible list called Folders, to which you can add custom folders by using the Add (+) button.

List of pictures, colors, and folders Select an item on the left, then click a picture or color on the right.
Dynamic Desktop pictures automatically change throughout the course of the day based on your current location. If Location Services is turned
off in Privacy preferences, the picture changes based on the time zone specified in Date & Time preferences.
Some dynamic desktop pictures may provide still images so the desktop picture doesn’t distract from the light or dark appearance. For example,
if you chose the dark appearance during macOS setup, the desktop picture is set to a dark still image. To use or stop using a still image (if
available), click the dynamic desktop, then choose a still image from the pop-up menu that appears.
If you don’t see anything when you select the Pictures folder, you either don’t have pictures in that folder or they don’t have the right file
format—JPEG, PICT, TIFF, PNG, or HEIC. To change a picture’s format, open it in the Preview app, then save it in the new format. If pictures look
fuzzy, try using larger ones, such as 1024 x 768 pixels.
Add(+) and Remove (–) To use an image from another folder, click the Add (+) button , then select a folder. Once the folder is added, you can
choose a picture from it. To remove a folder you added, select it, then click the Remove (–) button.
Fill Screen pop-up menu When you select a picture from Photos or the Pictures folder, choose how you want to arrange it on the screen—for
example, fill the screen or center the picture. Some choices may distort the picture.
Change picture Cycle through all the pictures available in the item or folder you selected in the list on the left. Use the pop-up menu to
choose how often to change the picture; for example, every hour. This option may affect the performance of some apps, such as games, that
use many graphics.
Random order When you choose to change pictures, you can also choose to display the pictures in a random order.
Translucent menu bar (not available on all Mac models) Make the desktop picture or color visible behind the menu bar.
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Screen Saver Tab
You will see a preview of the current screen saver. On the sidebar, you can select collections of built-in screen savers or choose Random to have
one be selected at random whenever the screen saver is activated. use the Start after menu to determine how long your Mac remains idle before
the screen saver starts. A clock can be overlaid on the screen saver, by checking Show with clock.

List of screen savers Select a screen saver on the left, then do one of the following on the right, depending on your choice:
• Click the Source pop-up menu, then choose a folder to use for slideshow pictures. To have the pictures appear in a random order, select
the “Shuffle slide order” checkbox.
• Click Screen Saver Options to customize the screen saver.
Start after Click the “Start after” pop-up menu, then choose how long your Mac needs to be inactive before the screen saver starts. If you don’t
want a screen saver to start, choose Never.
Show with clock Display the time with the screen saver.
Use random screen saver Let macOS choose which screen saver to use.
Hot Corners This button has options that are shared with Mission Control and provide the means to trigger various macOS functions when you
move the cursor into a screen corner. To use a modifier with the hot corner, press and hold the Command, Shift, Option, or Control key, or a
combination of these keys, while viewing the pop-up menus.
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Dock
Many of the Dock’s preferences can be adjusted by Control-clicking the thin line that divides apps and folders. However, the Dock pane in
System Preferences is worth exploring, because it provides a very clear visual overview of all your Dock’s settings.

Size This determines the size of the Dock icons and how much they expand when the cursor is over them.
Magnifacation This is best used when you’ve so many Dock icons that they’re not easy to pick out unless zoomed. If you don’t like the effect, you
can disable magnification entirely.
Position on screen This determines the screen edge the Dock sits on.
Minimize windows using This menu provides two effects for when windows are minimized to the Dock: Genie and Scale. Genie appears to ’suck’
the window into position. While Scale is a much simpler zoom that’s less taxing on older Macs and also a lot faster.
Prefer tabs when opening documents By default this is set to ‘In Full Screen Only’, but you can also choose ‘Always’ and ‘Manually’ from the drop
down menu. Setting to ‘Always’ will open new tabs in a window.
Double-click a window’s into application icon This enables you to select between zoom and minimize when making that action.
Minimize: Minimize an app window to an area at the end of the Dock.
Zoom: Expand a window to fill the space between the Dock and the menu bar. If the Dock is along the side of the screen, the window fills
the space below the menu bar and to the side of the Dock.
Minimize windows into application icon Minimize an app window to the app icon in the Dock. If the option is deselected, the window is
minimized to an area at the end of the Dock.
Animate opening applications This makes apps icons on the dock bounce while launching.
Automatically hide and show the Dock Hide the Dock when you’re not using it. To see the hidden Dock, move the pointer to the edge of the
screen where the Dock is located.
Show indications for open applications This places a little black dot beneath the icons of apps that are currently running.
Show recent applications in Dock Show recently opened apps (if they aren’t already included in the Dock) toward one end of the Dock.
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Mission Control
The Mission Control pane is the place for adjusting how Apple’s window overview works. On newer Macs, F3 is a Mission Control key. In this
preference pane, you can also control the settings for multiple desktops, called Spaces, that you can switch between.

Automatically rearrange Spaces on most recent use If you created multiple workspaces using Spaces, get quicker access to your most recently
used spaces
When switching to an application, switch to a Space with open windows for the application This option automatically switches you to a space
with an open window for an app when the app itself is switched to.
Group window by application This options groups windows by application. Turn it on and Mission Control groups app windows alongside the
app’s icon.
Displays have separate Spaces If you use Spaces and have multiple displays, you can set up separate spaces for each display.
Dashboard By default, Dashboard is off. If you want to use it, choose how Dashboard appears when you press its keyboard shortcut.
• As Space: Dashboard appears in a separate space. You can also move from another space to it.
• As Overlay: Dashboard appears over your desktop.
Keyboard and Mouse Shortcuts This provides a centralized area to define shortcuts for activating Mission Control and the ‘Application Windows’
feature (which shows only the windows of the currently active app), and showing the Desktop or Dashboard. For any keyboard shortcut, you
can define a function key or a modifier (a specific Shift, Control, Option or Command key), although the latter option isn’t usually a good idea,
because it makes the chosen modifier unavailable elsewhere. You can, however, combine a modifier and a function key: for example, to set
Shift+F1 to activate Mission Control, hold Shift, open the Mission Control menu, and click F1.
It’s worth noting that if your Mac keyboard includes a Mission Control icon on its F3 key, modifiers can be used in conjunction with that key in
order to access Mission Control functionality: Command+F3 shows the Desktop, and Control+F3 activates the ‘Application Windows’ feature.
Hot Corners This button has options that are shared with Mission Control and provide the means to trigger various macOS functions when you
move the cursor into a screen corner. To use a modifier with the hot corner, press and hold the Command, Shift, Option, or Control key, or a
combination of these keys, while viewing the pop-up menus.
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Language & Region
This pane controls the language shown in menus and dialog boxes, and the formatting of dates, times and currencies. It will by default use the
language you stated you wanted to use when you set up your Mac, along with the most appropriate formatting for your location.

Preferred languages The languages you want shown in macOS and in apps (for example, in menus and messages), and on websites (if available
in a preferred language). If macOS or an app supports the primary language, that language is used. If not, the other languages are used, in the
order listed. You can drag languages in the list to reorder them. If you add input sources, those languages are automatically added to the list.
Click Add (+) to add a new language or Remove (–) to delete a language from the list
Region The geographic region whose formats are used for dates, times, numbers, and currencies. When you choose a different region, the
options and the preview shown change.
First day of week The day on which a calendar week starts. This value is used in apps such as Calendar.
Calendar The type of calendar used to display dates and times.
Time Format Use a 24-hour format for the time shown in the menu bar. For example, instead of 3:00 PM, show 15:00.
Temperture changes between Fahrenheit and Centigrade.
Numbers The characters used to display numbers. This option is available only for some primary languages, such as some Arabic or Indian
languages.
Keyboard Preferences Open the Input Sources pane of Keyboard preferences, where you can add and remove input sources, and set options for
input sources.
List sort order The order used to sort items by name in the Finder. This option appears only if you add a language or input source that offers a
sort order other than Universal.
Advanced Change the language and formats used to display dates, times, numbers, and currencies in Finder windows and apps, such as Mail.
For example, if the region for your Mac is set to United States, but the format language is set to French, then dates in Finder windows and email
messages appear in French. If you just want to change how time is shown in the menu bar, select the “Time format” checkbox in the Language &
Region preference pane, or select the 24-hour option in the Clock pane of Date & Time preferences. To show the date in the menu bar, also select
“Show Date” in the Clock pane.
In the General pane, you can choose the language to use for showing dates, times, and numbers, and set formats for numbers, currency, and
measurements.
In the Dates and Times panes, you can type in the Short, Medium, Long, and Full fields, and rearrange or delete elements. You can also drag new
elements, such as Quarter or Milliseconds, into the fields. If you’re not using a 24-hour clock, you can replace AM and PM with whatever you type
in those fields.
To undo all of your changes for a region, choose the region again from the Region pop-up menu. To undo just your changes to advanced
options, click Advanced, click the pane where you want to undo your changes, then click Restore Defaults
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Security and Privacy - General Tab
You can use the settings in this pane to make your Mac more secure from malware and tampering.

Change Password Click to change the login password for the current user.
Require password... after sleep or screen saver begins Use this setting to lock your Mac when it’s left in an idle state. When the Mac wakes, a user
login password must be entered before the Mac can be used. You can select the amount of time after the screen saver or sleep begins before a
password is required.
Show a message when the screen is locked Select to display a short message in the login window when your Mac is locked. The message will be
shown to any users who attempt to log in. It can also be used to provide contact information for a lost Mac.
Disable automatic login Select to require users to authenticate with a password when they log in.
Note: this will appear only if FileVault is turned off.
Allow your Apple Watch to unlock your Mac Use your Apple Watch (instead of entering your password) to unlock your Mac when you wake it
from an idle state. This option is available only if your Mac supports Auto Unlock.
Allow apps downloaded from
App Store Select to allow only apps that have been downloaded from the Mac App Store.
App Store and identified developers Select to allow apps only from the Mac App Store, and from developers identified by Apple.
Lock Locks or unlocks Security & Privacy preferences. Click the lock icon to unlock it, then enter an administrator name and password.
Advanced
Log out after... minutes of inactivity Select to automatically log out users after the Mac is idle for the given number of minutes.
Require an administrator password to access system-wide preferences Select to prevent users from changing locked system preferences
without an administrator’s password.
Disable remote control infrared receiver Select to prevent your Mac from receiving commands from an infrared remote control. (This
option appears on Mac computers with infrared ports.) To configure your Mac to respond to an infrared remote control, deselect the
checkbox, click Pair, then follow the onscreen instructions.
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Security and Privacy - Filevault
You can use FileVault encryption to protect the confidential information on your Mac. FileVault encodes the information stored on your Mac so
that it can’t be read unless the login password is entered.

WARNING: Don’t lose your recovery key. Store your key in a safe place that you can get access to. This means do not store the
recovery on your computer that you have encrypted with FileVault. Without your passwords or your recovery key, you or Apple will
not be able to get access to your computer.
Turn On FileVault Click to securely encrypt all the information currently on the startup disk, and encrypt and decrypt new information as it is
read and written to storage. The initial encryption may take a while, depending on the amount of data that is stored, but you can use your Mac
while encryption is taking place.
When you turn on encryption, all users are required to use a password to log in. You will receive a recovery key that you can use to unlock the
disk in case you forget the login password. You can add other users who are allowed to unlock and access the information on your Mac.
Turn Off FileVault Click to decrypt the encrypted information on your Mac and stop encrypting new information.
Enable Users Click to allow users to log in at startup and unlock the encrypted information on the Mac. Users that are not enabled need an
administrator to log in before they can use the Mac.
Tips
Setting up FileVault
You must be an Administrator to set up FileVault on your Mac.
Multiple Users
If you have multiple regular or administrative accounts set up on your Mac, you’re prompted to choose which accounts may unlock the volume’s
encryption key at startup. If your Mac has only a single user account configured, FileVault skips this step.
Unencrypted Users
Once FileVault is enabled, any user not FileVault enabled will need an Administrator to log in first. Only users that are FileVault enabled can log in
with out an administrator.
Recovery Key
macOS presents you with a 24-character alphanumeric recovery key, which can be used to unlock a FileVault-encrypted disk even if you
forget the password for every account authorized to boot up the system. You should write down this recovery key; or copy, paste, and store it
somewhere secure. Just be sure you save it in a location other than this computer’s drive, so you’ll be able to retrieve it should you be locked out
of the drive. Alternatively you can opt to have Apple store your recovery key.
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Security and Privacy - Firewall
Use this pane to turn on the firewall in macOS to prevent unwanted connections from the Internet or other networks.

Turn On Firewall If the firewall is turned off, click Turn On Firewall to turn on firewall protection.
Firewall Options Click the Firewall Options button to change firewall settings. Note: this button is greyed out if the Firewall is turned off.
Block all incoming connections In Firewall Options, select to prevent incoming connections to nonessential services and apps. Basic Internet
services are a set of apps that allow your Mac to find services provided by other computers on the network. This setting prevents connections to
all other sharing services.
Add (+) In Firewall Options, to add an app or service, click the Add (+) button, select the item in the list, then use the Up Arrow and Down Arrow
keys to set the limits for the app.
Remove (–) In Firewall Options, to remove an app, select it in the list, then click the Remove (-) button.
Automatically allow built-in software to receive incoming connections In Firewall Options, select to allow built-in apps and services that are
signed by a valid certificate authority to be automatically added to the list of allowed apps, without your authorization. For example, iTunes is
signed by Apple, so it is automatically allowed to receive incoming connections through the firewall.
Automatically allow downloaded signed software to receive incoming connections In Firewall Options, select to allow apps and services that are
signed by a valid certificate authority to be automatically added to the list of allowed apps, without your authorization. For example, iTunes is
signed by Apple, so it is automatically allowed to receive incoming connections through the firewall.
Enable stealth mode In Firewall Options, select to prevent your Mac from responding to probing requests that can be used to reveal its
existence. The Mac still answers requests from authorized apps, but unauthorized requests such as ICMP (ping) get no response.
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Security and Privacy - Privacy
Use this pane to manage the information your Mac makes available to others across the Internet or on a network.

Location Services When you turn on Location Services, you allow apps and websites to use your Mac’s current location to provide information,
services, and features appropriate to where you are. System Services allow the location of your Mac to be used by Spotlight or Spotlight
Suggestions in Safari.
Manage which apps can use Location Services Select the checkbox next to an app to allow it to use Location Services. Deselect the
checkbox to turn off Location Services for that app. If you turn Location Services off for an app, you’re prompted to turn it on again the
next time that app tries to use your location data.
If you allow third-party apps or websites to use your current location, you are subject to their terms and privacy policies and not the Apple
Privacy Policy. You should review their terms and privacy policies to understand how they treat and use your location information.
When you use Safari and Spotlight Suggestions, the location of your Mac at the time you submit a search query to Safari or Spotlight is
sent to Apple to make suggestions more relevant and to improve other Apple products and services.
Contacts, Calendars, and Reminders Shows the apps that want access to your contacts, calendars, or reminders. Deselect the app if you want to
prevent it from accessing this information.
Photos Shows the apps that have requested access to Photos on the Mac.
Camera Shows the apps that have requested access to the camera on the Mac. Deselect the app if you want to prevent it from controlling your
camera.
Microphone Shows apps that have requested access to the microphone on the Mac. Deselect the app if you want to prevent it from controlling
your microphone.
Accessibility Shows apps that run scripts and system commands to control your Mac. Deselect the app if you want to prevent it from controlling
your Mac.
Full Disk Access Shows apps that can access data from other apps (including Mail, Messages, Safari, and Home), data from Time Machine
backups, and certain administrative settings for all users on this Mac.
Automation Shows apps that can access and control other apps on your Mac. Deselect the app if you want to prevent it from controlling
other apps.
Analytics o help Apple and other developers serve customers better and improve the quality of their products, you can choose to automatically
send analytics information to Apple and app developers.
Advertising Sometimes you’ll receive ads in Apple apps and on your macOS devices that are targeted to your interests. To limit these ads,
click the Limit Ad Tracking checkbox. You may still receive ads, but they won’t be sent based on data captured by ad tracking. To view what
information about your device is used to deliver ads to you in Apple News, Stocks, and the Mac App Store, click View Ad Information.
To review Apple’s Advertising and Privacy policy, click About Advertising and Privacy.
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Spotlight
The Spotlight System Preferences pane enables you to define the kind of results that appear in Spotlight, along with the content Apple’s search
system happens to index

Search Results pane
Choose which categories appear in Spotlight search results: Select the categories you want to include, deselect those you don’t. By default,
Spotlight results include Spotlight Suggestions, Bing Web Searches, conversions, documents, folders, music, and more. Allow Spotlight
Suggestions in Spotlight and Look Up: Show Spotlight Suggestions in results when you search in Spotlight and look up a word.
If you don’t want your Spotlight and Look Up search queries and Spotlight Suggestions usage data sent to Apple, you can turn off Spotlight
Suggestions. Deselect the “Allow Spotlight Suggestions in Spotlight and Look Up” checkbox (which automatically removes Spotlight
Suggestions from the list), then deselect the Bing Web Searches checkbox in the list. With the checkboxes turned off, Spotlight searches only the
contents of your Mac, and Look Up searches only the dictionary on your Mac.
You can turn off Location Services for Spotlight Suggestions in Security & Privacy preferences. If you turn off Location Services on your Mac, your
precise location will not be sent to Apple.
Privacy pane
Keep Spotlight from searching locations: Click the Add button , then locate the folder or disk you want to exclude. You can also drag folders or
disks into the list. Remove a folder or disk from the exclusion list: Select the folder or disk, then click the Remove button .
If you add a Time Machine backup disk to the privacy list, you will continue to see messages that Spotlight is indexing your backup disk. This
indexing is necessary for Time Machine to function properly and can’t be disabled. Spotlight does exclude from searches any items you store on
your backup disk that are not part of a Time Machine backup.
Important: If you add certain files and folders to the privacy list you may not be notified when updates become available for some apps. If you
add your entire internal disk to the privacy list, you won’t be notified about any updates.
Keyboard Shortcuts Takes you to the Keyboard Shortcuts Preference Pane.
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Notifications
Specify when you don’t want to be disturbed by notifications, and set options to control how apps show notifications and how they’re sorted in
Notification Center.

Do Not Disturb Stop notifications during the time range you specify, when the display is sleeping, or when you’re projecting the screen.
Select checkboxes to receive call notifications even when Do Not Disturb is on.
Note: You can quickly pause notifications until midnight by clicking the Notification Center icon in the menu bar, swiping down, then turning on
Do Not Disturb.
[App] alert style Select a style for the app’s notifications:
None: Notifications don’t appear on the screen.
Banners: Notifications appear on the screen and disappear after a while.
Alerts: Notifications stay on the screen until you dismiss them.
Show notifications on lock screen When you wake your Mac from sleep, app notifications you received while it was in sleep are shown in the
login window.
Show notification preview Show a preview in the notification. For example, if you receive an email, you see a preview of the email in the Mail
notification. If you chose to show notifications on the lock screen, you can choose when to show the preview.
• when unlocked: Previews are shown only when you’re logged in to your user account.
• always: Previews are always shown (even in the login window).
Show in Notification Center Choose how many of the app’s recent notifications to list in Notification Center. Notifications older than seven days
aren’t shown.
Badge app icon Let the app show the number of notifications on its icon in the Dock.
Play sound for notifications Let the app play notification sounds.
Notification Center sort order Choose how notifications are sorted in Notification Center:
• Recents: Notifications are sorted by time, with the most recently received at the top. Notifications older than seven days aren’t shown.
• Recents by App: Notifications are grouped by app; the app with the most recent notification is listed first.
• Manually by App: Notifications are grouped by app; the apps are sorted based on the order in which they’re listed in Notifications
preferences when this option is chosen. You can reorder apps in the list by dragging them up or down.

16

macOS Mojave System Preferences
Displays
The options you’ll see within the Displays pane are in part reliant on your Mac hardware. You’ll see Display and Color tabs and if you have
multiple displays, an added Arrangement tab will appear. When Night Shift is turned on, it will gradually shift the display from blue to a subtle
yellow, reducing the exposure to blue light. Blue light is believed to interrupt the circadian rhythm, disrupting sleep patterns.

Resolution On non-Retina Macs, specific resolutions will be listed (such as 1920 x 1200); on Retina Macs, you instead get pictorial representations
of what your selection will achieve, labelled with the likes of ‘Larger Text’ and ‘More Space’. Clicking an option will immediately change your
display’s resolution.
Brightness The slider adjusts the display’s brightness setting more rapidly than using your keyboard’s media keys (F1 and F2), and on notebooks
you’ll have an optional checkbox for automatically adjusting brightness; this is worth keeping on at all times unless you find it doesn’t work well
for you.
Automatically adjust brightness or Ambient light compensation If your Mac has ambient light sensing, you can have the display brightness
adjust automatically based on current light conditions.
Rotation Rotates the image shown on your display by the chosen amount. Display must be able to support screen rotation.
True Tone Automatically adjusts the colors on the display based on current ambient lighting conditions.
AirPlay Display Use AirPlay Mirroring to wirelessly send what’s on your Mac to another display.
Refresh Rate How frequently your screen is redrawn.Show displays in menu bar Displays an icon in the menu bar that lets you switch between
your most frequently used resolutions.
Overscan If you’re using a TV as a display and you can’t see the menu bar, select this option.
Show mirroring options in the menu bar when available Show devices available for AirPlay Mirroring in the menu bar.
Color Tab
Display profile Select a display profile in the list to use for your system. After selecting a display profile, you can:
• See the details of the color profile by clicking Open Profile.
• Delete a custom color profile by clicking Delete Profile..
Calibrate Click Calibrate to calibrate your display and create a custom profile that accounts for your current light conditions, and the position and
angle of the display.
Show profiles for this display only Show only the profiles that can be applied to the display on which you’re viewing Displays preferences.
Night Shift Tab
Schedule
Off: Don’t schedule a time for Night Shift (if you choose this, you can still turn on Night Shift manually).
Custom: Choose the times when Night Shift turns on and off.
Sunset to Sunrise: Turn on Night Shift from sunset to sunrise.
Manual Select to turn on Night Shift; deselect to turn it off. Night Shift remains on until the next day or until you turn it off. When activated, you
can turn it on or off through this Preference Pane or through your Notifications.
Color Temperature Adjust the color temperature to your liking.
Arrangment Tab (appears when one or more monitor are connectd)
Display graphic representation Drag any of the displays to a different position. You can also drag the menu bar to any display.
Mirror Displays Simultaneously show the same image on your Mac and all connected displays.
Gather Windows Moves all open Displays preferences windows to the display where this button is. This button appears only if more than one
display is connected to your Mac.
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Energy Saver
Use Energy Saver preferences to set options that control your computer’s energy use. If you have a portable Mac, these options also help you
extend your battery’s life.

Battery, Power Adapter or UPS Click Battery, Power Adapter, or UPS, then select energy-saving options for that power source. Your Mac will use
those options when it’s getting power from that source.
Note: You see the Battery button only if you have a portable Mac. You see the UPS button only if your Mac is connected to an uninterruptible
power source.
Put hard disks to sleep when possible Put the computer’s hard disk to sleep whenever it’s inactive.
“Computer sleep” and “Display sleep” sliders, or “Turn display off after” slider Drag the slider to set the amount of time your computer or display
should wait before going to sleep.
Wake for network access Users can access your computer’s shared resources, such as shared printers or iTunes playlists, even when your
computer is in sleep mode.
Slightly dim the display while on battery power Reduce the brightness of the display while on battery power. Note: Appears in the Battery Tab.
Enable Power Nap Permits your computer to check for email, calendar, and other iCloud updates while sleeping. If turned on for Ethernet, your
computer can also back up using Time Machine.
Allow power button to put computer to sleep Allows you to press the power button to put your computer to sleep.
Prevent computer from sleeping automatically when the display is off Prevents the computer from going to sleep when the display sleeps.
Start up automatically after a power failure Start up your Mac after a power interruption.
Show battery status in menu bar Show the battery icon in the menu bar. The battery icon shows when your portable Mac is connected to a
power supply and the battery is charging , or shows the battery’s charge level . You can also choose to show the percentage of battery power
remaining.
Schedule Set a daily schedule for putting your Mac to sleep or turning it off and on.
Automatic graphics switching To extend the life of your battery, set your Mac to automatically switch between graphics modes.
Note: Depending on the kind of Mac you have, some options may not appear in the Preference Pane. For example, you will not see a Battery tab
on an iMac, Mac Mini or Mac Pro.
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Keyboard
The Keyboard pane provides a great deal of control over keyboard input. The Keyboard tab has controls that change how your hardware works.

Key Repeat/ Delay Until Repeat How fast characters repeat when you press and hold certain keyboard keys, and how long to wait before
repeating them.
Use all F1, F2, etc. keys as standard function keys This determines whether the top row of keys on your keyboard performs actions such as
adjusting brightness and switching tracks in iTunes, or literally sends function-key-presses. The latter is often helpful in design software. Check
the checkbox and special features will require you to also hold the ‘fn’ key to activate them.
Show keyboard and emoji viewers in menu bar This enables you to access the Keyboard Viewer and Emoji & Symbols from the menu bar.
Modifier Keys Using the menus in the drop-down sheet, you can turn off modifiers (Caps Lock, Control, Option/Alt, Command), or swap them
round.
Setup Bluetooth Keyboard Use an Apple wireless keyboard, mouse, or trackpad with Mac.
For Portable Macs
Adjust keyboard brightness in low light If your portable Mac has a backlit keyboard, have it automatically adjust the level of backlighting in low
light conditions.
Turn keyboard backlight off after [time period] of inactivity If your portable Mac has a backlit keyboard, have it automatically turn backlighting
off after your Mac is idle for the specified time period.
Touch Bar shows If your Mac has a Touch Bar, choose what is shown in it: App Controls with Control Strip, Expanded Control Strip, or App
Controls.
Show Control Strip If your Mac has a Touch Bar, choose whether or not to display the Control Strip when you choose App Controls or Quick
Actions from the “Touch Bar shows” pop-up menu.
Press Fn key to If your Mac has a Touch Bar, choose what happens when you press the Fn key: Expand Control Strip; Show App Controls; Show
Control Strip; Show F1, F2, etc. Keys; or Show Quick Actions. The choices available depend on the setting in the “Touch Bar shows” pop-up menu.
Customize Touch Bar Change which buttons are shown in the Control Strip portion of the Touch Bar. You can also customize the Control Strip
directly in apps.
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Keyboard - Text
Use the Text pane of Keyboard System Preferences to set options for replacing text, correcting spelling, and using smart quotes and dashes.

Replace list, With list The Replace list shows words and phrases you want to replace as you type them; the With list shows the replacement words
and phrases. To change a word or phrase in either list, click it, then type a new word or phrase. For more information, go to https://goo.gl/qB8CsC
Add (+), Remove (-) Add or remove words or phrases from the lists.
Correct spelling automatically Enable automatic spelling correction in any app that supports it. You can change the setting for this option in an
app by choosing the command from the app’s Edit > Spelling and Grammar menu.
Capitalize words automatically Enable automatic capitalization correction in any app that supports it. This automatically capitalizes the first word
of a sentence and proper nouns (such as, New York or Sonia) as you type.
Add period with double-space Enable this option to quickly end a sentence with a period and a space by just pressing the space bar twice.
Touch Bar typing suggestions If your Mac has a Touch Bar, enable this option to display typing suggestions in the Touch Bar as you type.
Spelling By default, spelling is checked automatically by language (useful if you type in different languages). To select the languages that are
checked automatically, choose Set Up from the pop-up menu.
To have spelling checked for a specific language, choose the language from the pop-up menu.
Use smart quotes and dashes Enable typographical quotes and dashes, using the selected styles, in any app that supports them.
Keyboard - Shortcuts
Keyboard shortcuts let you quickly perform tasks by pressing keys on your keyboard. For a list of macOS keyboard shortcuts, go to https://
goo.gl/hAH3iM. You can disable or change many of the “global” keyboard shortcuts, which are shortcuts that work the same in most apps (for
example, taking a picture of the screen by pressing Command-Shift-3).
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Keyboard - Input Sources
The Input Sources tab enables you to add different keyboard layouts that you can switch between, such as ones that aid input in alternate
languages, or the Dvorak ‘simplified keyboard’, which rearranges the keys in an attempt to increase typing rates and decrease errors.
Add (+), Remove (-) Add or remove different type of keyboards or
different language keyboards.
Input source preferences If the selected input source provides
preferences, they appear in the area on the right. For example, if a
Hebrew input source is selected, options for bidirectional text are
shown.
Show Input menu in menu bar The Input menu appears in the
right side of the menu bar. It contains enabled input sources,
and offers a fast way to switch between them. This option is
automatically selected when you add input sources.
Automatically switch to a document’s input source Choose an
input source for a document and have it used every time you
work in the document until you close it, even if you switch to
other documents that use other input sources in the meantime.
This option appears only when you add a second input source.

Chinese, Korean, and Japanese input sources include numerous options. If you added one of these input sources, switch to it (using the Input
menu in the menu bar), then open its help to learn about the options.
Keyboard - Dictation
This provides access to the interface for setting up dictation functionality. You choose an input source from the menu under the mic icon, select
a language from the ‘Language’ menu, and choose a shortcut for activating dictation (Fn twice by default) from the ‘Shortcut’ menu.
Dictation: On/Off Turn dictation on and off.
Microphone Click the pop-up menu below the
microphone icon, then choose a microphone. If you
choose Automatic, your Mac listens to the device you’re
most likely to use for dictation.
Language Choose your language. Dictation is not
available in all languages. If you don’t see the language
you want in the pop-up menu, choose Add Language or
Customize to download it. You can download multiple
languages. If you no longer want to use a language you
downloaded, you can remove it. Click the Language
pop-up menu, choose Customize, then deselect the
language you don’t want to use.
Shortcut By default, you press the Fn (Function) key
twice to start or stop dictation. If you like, you can
choose a different shortcut from the pop-up menu. To
create a shortcut that’s not in the list, choose Customize,
then press the keys you want to use. For example, you
could press Option-Z.

About Dictation and Privacy Click to see a message about how Dictation sends your dictated speech to Apple and uses your personal
information such as your name, your contacts, and other data to understand you better and recognize what you say.
Use Enhanced Dictation With Enhanced Dictation, you can dictate offline, without an Internet connection. You can also use dictation commands
(also known as spoken commands) to perform tasks and control your Mac while dictating text. You can use a dictation keyword phrase, which
allows you to use dictation commands even when you’re not dictating text.
The first time you turn on Enhanced Dictation, and when you add languages to use with it, macOS downloads additional software that allows
dictation to work offline. The amount of free disk space required to download this software varies depending on the language.
If you don’t want to download the software required to use Enhanced Dictation, you can deselect Enhanced Dictation and use server-based
dictation. With server-based dictation, your words are quickly sent to Apple servers to be analyzed using the latest language data. The final
converted text appears after you end dictation.
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Mouse
Set your preferences for a mouse connected to your Mac. The pane’s appearance can vary depending on the mouse connected. Plug in a regular
Apple Mouse and you will see different settings for the mouse.

Magic Mouse
Magic Mouse is a point-and-click mouse that lets you click and double-click anywhere on the Multi-Touch surface. The Multi-Touch area covers
the whole surface of Magic Mouse, and the mouse itself is the button. Scroll in any direction with one finger, swipe through webpages and
photos with two fingers, and click or double-click anywhere.
Point and Click:
• Scroll direction: natural: Select this option to move the contents of a window in the same direction as your fingers.
• Secondary click: Select the option, then choose “Click on the right side,” or “Click on the left side” to secondary (or Control) click items on
your screen.
• Smart zoom: Select this option to double-tap with one finger to zoom in or out.
• Tracking speed: Adjusts how fast the pointer moves when you drag the mouse.
More Gestures:
• Swipe between pages: Select this option and choose “Scroll left or right with one finger,” “Swipe left or right with two fingers,” or “Swipe
with one or two fingers” to move between pages in a document.
• Swipe between full-screen apps: Select this option to move between apps in full screen.
• Mission Control: Select this option to double-tap with two fingers to enter Mission Control.
Mouse battery level: Shows how much charge is left on your Magic Mouse
Apple Mouse
Apple Mouse is a wired, point-and-click mouse that lets you click and double-click anywhere on the surface. The Apple Mouse’s Scroll Ball offers
full 360-degree scrolling capability. When you give the Apple Mouse a squeeze, force-sensing side buttons can be configured to activate Mac
macOS features such as Dashboard, Exposé or a whole host of other customizable featuresScroll direction: Natural: Select this option to move
the contents of a window in the same direction as your fingers.
• Scroll direction: natural: Select this option to move the contents of a window in the same direction as your fingers.
Set the sliders. As you adjust the sliders, try moving and clicking your mouse to see the effect of your changes.
• Tracking: Adjusts how fast the pointer moves when you drag the mouse.
• Double-Click: Adjusts how rapidly you must click for your Mac to recognize a double-click.
• Scrolling (if your mouse has a scroll ball or wheel): Adjusts how quickly the pointer moves when you scroll. The scroll ball doesn’t scroll
menus or sliders in dialogs.
Set Up Bluetooth Mouse Allows you to remove a bluetooth Mouse from your Mac.
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Trackpad
The Trackpad pane enables you to define functionality for your notebook’s built-in trackpad, or for a Magic Trackpad connected to a desktop
machine via Bluetooth. The Trackpad pane provides three tabs: Point & Click, Scroll & Zoom and More Gestures.

Point & Click Tab
Look up & data detectors Select this option to quickly look up a word or do quick tasks with certain types of data, such as dates and addresses,
then choose “Force click with one finger,” or “Tap with three fingers.”
Tap to click If you select this option, tapping the trackpad with one finger is the same as clicking.
Secondary click Select the option, then choose “Click with two fingers,” “Click in bottom right corner,” or “Click in bottom left corner” to secondary
(or Control) click items on your screen.
Look up Select this option so you can use three fingers to double-tap a word to look it up in the dictionary.
Three finger drag Select this option so you can use three fingers to drag an item on your screen.
Tracking Speed Drag the slider to set the tracking speed of the pointer when you move it across the screen.
Silent clicking Select this option to turn off the clicking sound on a Force Touch trackpad.
Force click and haptic feedback On a Force Touch trackpad, force click an item to take action. (To force click, press firmly until you feel a deeper
click.) For example, force click a file in the Finder to show it in a Quick Look window. With the checkbox selected, you also feel tactile feedback
when aligning objects in some apps, like Preview.
Scroll and Zoom Tab
Scroll direction: natural Select this option to move the contents of a window the same direction as your fingers.
Zoom in or out Select this option to pinch two fingers closed to zoom in, or pinch two fingers open to zoom out.
Smart zoom Select this option to double-tap with two fingers to zoom in or out.
Rotate Select this option to use two fingers to rotate items on your screen.
More Gestures Tab
Swipe between pages Select this option, then choose “Scroll left or right with two fingers,” “Swipe with three fingers,” or “Swipe with two or three
fingers” to move between pages in a document.
Swipe between full-screen apps Select this option, then choose “Swipe left or right with three fingers” or “Swipe left or right with four fingers” to
move between apps in full screen.
Notification Center Select this option to swipe left from the right edge of the trackpad to show Notification Center.
Mission Control Select this option, then choose “Swipe up with three fingers” or “Swipe up with four fingers” to enter Mission Control.
App Exposé Select this option, then choose “Swipe down with three fingers” or “Swipe down with four fingers” to use Exposé.
Launchpad Select this option to pinch your thumb and three fingers to display Launchpad.
Show Desktop Select this option to spread your thumb and three fingers to reveal your computer’s desktop.
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Printers & Scanners
Use Printers & Scanners preferences to manage printers, scanners, and fax machines.

List of printers, scanners, and fax machines Click a device to see information, including its location and status.
Add (+) button To add a printer or scanner, click the Add (+) button , then choose from the list or type the device’s information into the dialog
that appears. Most printers and scanners are listed under Default. You can also add a fax machine, IP printer, or Windows printer
Remove (–) button To remove a device, select it, then click the Remove (–) button
Open Print Queue Open the print queue for the selected printer, where you can pause the printer, delete a print job, or move a job to another
printer.
Options & Supplies View general information for the selected printer, check supply levels, or update options you added to the printer.
Share this printer on the network Let other users use your printer. They can be using a Mac, Windows, or a UNIX computer, and must be on the
same local network. Mac users must have Mac OS X v10.4 or later.
Open Scanner To scan a document or image, select the scanner, then click this button.
Default printer If you choose Last Used Printer, macOS remembers the printer you used most recently at that network location.
Default paper size Choose the paper size you have loaded in your printer.
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Sound
The Sound pane is where you define system alert sounds, and settings for audio inputs and outputs. It has three tabs: Sound Effects,
Output and Input.

Sound Effects Tab
Select an alert sound This tab enables you to select an alert sound. Funk is the default
Play sound effects through This enables you to define through which output you’d like alerts played. This defaults to your choice of sound
output device, but can be overridden by selecting an alternate option.
Alert volume Using the slider, volume level can be adjusted to suit
Play user interface sound effects Turns on/off the user interface sounds, for example dragging something to the trash.
Play feedback when volume is changed Turns on/off sound when changing the output sound.
Output volume Using the slider, volume level can be adjusted to suit.
Mute Mutes sound on computer.
Output Tab
Choose a sound output device From the list of sound output devices, select the one you want to use. All sound output devices available to your
Mac are listed, including the computer’s internal speakers, devices plugged into your computer’s sound port (Audio port icon), USB speakers,
and AirPlay devices.
Adjust sound output settings You can adjust balance and volume for sound output with the controls in the preference pane. If you select the
“Show volume in menu bar” checkbox, a volume control appears in the menu bar so that you can turn the volume up or down from anywhere.
To set a separate volume for alert sounds, click Sound Effects.
Input Tab
Choose a sound input device From the list of input devices, select the one you want to use. All sound inputs available to your Mac are listed. If
your display has an internal microphone, it’s listed as “Display Audio.”
Adjust sound input settings If you’re recording sound through your computer’s sound port, you can adjust the input volume to compensate for
the sound source being too loud or quiet.
For example, if you’re recording loud music, lower the input volume so the recorded sound isn’t too loud or distorted. Or if you are recording
someone who is speaking softly, increase the input volume so your Mac can better capture the person’s voice.
To capture less background noise when using your computer’s built-in microphone, select “Use ambient noise reduction.”
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Startup Disk
You can tell your Mac which disk to start up from when more than one startup disk is connected. A “startup disk” is a volume or partition of
a drive that contains a usable operating system. You can set your Mac to automatically use a specific startup volume, or you can temporarily
override this choice at startup.

Set the default startup disk You can change the startup disk your Mac automatically uses from System Preferences.
1. From the Apple menu choose System Preferences.
2. Click the Startup Disk icon in System Preferences, or choose View > Startup Disk.
3. Select your startup disk from the list of available volumes.
Target Disk Mode Target disk mode lets you share files between two Mac computers with FireWire, Thunderbolt 2, USB-C, or Thunderbolt 3
(USB-C) ports. This is useful when you need high transfer speeds or if the display on one of your computers isn’t working and you need to get
files from it. Essentially, it makes your Mac act as an external hard drive.
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iCloud
Use iCloud preferences to sign in or out of iCloud, turn iCloud features on or off, change iCloud account details, or manage iCloud storage.

Account Details Make changes to your iCloud account, such as: name, email address, passwords, Two-factor authentication or two-step
verification, payment method or rescue email.
Family Sharing/Manage Family You see a Family Sharing button if you haven’t joined a family. You will see Manage Family button when:
• You received an invitation and want to join a family.
• You’re a family member and want to stop sharing your purchases, or leave the family.
• You set up Family Sharing and want to manage the family. For example, you want to add members or resend an invitation to join, or to
control young family members’ spending.
Change feature settings Turn on features you want to use, and turn off features you don’t want to use. Some features have additional settings
you can change by clicking Options or Details near the feature name when the feature is turned on. If you turn on Contacts while your Contacts
app is synced with Google Contacts, Google syncing is turned off. You should keep it turned off while using iCloud for your contacts.
Change iCloud Drive options If iCloud Drive is turned on, click Options to select which apps can:
• Store documents and data in iCloud Drive
• Let other people look you up by your email address (the one you use as your Apple ID for iCloud)
Change iCloud Photos options If Photos is turned on, click Options to turn the following features on or off:
• Store your entire Photos Library in iCloud
• Import your recent photos from devices without iCLoud Photo Library through My Photo Stream
• Create albums to Share with other people and subscribe to other people’s Photo album
Change iCloud Keychain options If Keychain is turned on, and your iCloud account isn’t enrolled in two-factor authentication, click Options to
change:
• Whether your iCloud Security Code can be used to approve iCloud Keychain on new devices
• The iCloud Security Code and the phone number used to verify your identity after you use the iCloud Security Code
If “Waiting for approval” appears below Keychain, click Options to enter your iCloud Security Code instead of approving this Mac from another
device. If you forgot your code, you can reset iCloud Keychain.
The Options button doesn’t appear if the Apple ID you use for iCloud is enrolled in two-factor authentication. With two-factor authentication,
iCloud Keychain doesn’t need an iCloud Security Code or approval from another device
Change Find My Mac details I f “Location Services is off” appears below Find My Mac, click Details, then follow the onscreen instructions so you
can locate this Mac.
Manage iCloud storage When you sign up for iCloud, you automatically get 5 GB of free storage. Your iCloud storage is used for documents
stored in iCloud Drive, iCloud Photo Library, iOS device backups, messages and attachments in iCloud Mail and more. If you run out of space, you
can upgrade your storage. You can also remove stored items to make more space available.
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Internet Accounts
Use Internet Accounts preferences to quickly set up your Internet accounts from Google, LinkedIn, Yahoo!, and other providers for multiple Mac
apps, such as Mail, Contacts, Calendar, Notes, Reminders, and Messages.

WARNING: Deleting an account or turning off individual account features can remove data stored in your apps.
List of accounts (on the left) Shows the accounts already set up on your Mac. Select an account to see its features and settings.
List of account features or list of account types (on the right) If an account is highlighted on the left, its features and settings are listed on the
right. Select the features you want to use and change settings as you like.
If no account is highlighted on the left, you can add one by clicking a provider such as iCloud on the right.
Add (+) button To add an account, click the Add (+) button , then in the list that appears on the right, click an account provider. If you don’t yet
have an account from a particular provider, such as Yahoo!, create one on the provider’s website, then add it here.
If you want to add an account from a provider that isn’t listed, such as a mail or calendar account for your company or school, click Add Other
Account on the right, click the type of account you want to add, then enter the requested account settings. If you don’t know the type of
account or the account settings, ask the account provider.
If you don’t have an account you want to add, create one on the provider’s website or request one from your network administrator.
Remove (–) button To remove the highlighted account and turn off all its features, click the Remove (–) button. If your Mac is set up for iCloud
Keychain when you remove an account (other than your primary iCloud account), you’re asked whether to remove the account from your other
Mac computers set up for iCloud Keychain, or just turn off all the account features on this Mac.
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Software Update
Use Software Update preferences to update your macOS software and set whether your Mac checks for and downloads new updates
automatically.

Update Now Click Update Now to install all the available system software and updates that appear in the Software Update pane. If you don’t see
an Update Now button, there are no available updates.
More info Click “More info” to view information about available updates. Select an update to see information about it. To install updates, select
the checkboxes of the updates you want and click Install Now.
Automatically keep my Mac up to date Select this checkbox to have your Mac install updates automatically.

Advanced
Check for updates Have your Mac check for updates automatically.
Download new updates when available Have your Mac download updates without asking you.
Install macOS updates Have your Mac install macOS updates automatically.
Install app updates from the App Store Have your Mac install app updates from the App Store automatically.
Install system data files and security updates Have your Mac install system files and security updates automatically.
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Network
The Network pane is where you define network settings, enabling you to connect to the likes of wireless routers or corporate ethernet.

Location used to define specific set-ups for different places, such as home, work, or even your friends house. If you want to create a new location,
from the drop-down menu, select Edit Locations. Click on the Add (+) button to create a new location.
Services (Listing on the left hand pane) This is a list of available connection types and settings related to the currently selected service. A green
dot next to the service indicates, You are connected to a network. A yellow dot indicates the service is on but not connected to a network. A red
dot indicates the service is off.
Add (+) button To add a new network service, click the Add (+) button , then choose an interface type and the service’s name.
Remove (–) button To remove a network service, click the Remove (–) button. Removal is immediate but can be undone using the Revert button.
Action Menu This enables you to duplicate or rename the selected service, or to make it inactive. You can set the service order, to prioritise
certain connection types. The other options include the means to import and export configurations, and ‘Manage Virtual Interfaces’, for editing a
list of such interfaces
Advanced This opens a multi-tabbed sheet that enables you to drill down into the fine detail of network connections. Available tabs will depend
on the selected service, but may include: Wi-Fi, TCP/IP, DNS, WINS, 802.1X, Proxies, Hardware and Bridge Status.
• Wi-Fi You can reorder known Wi-Fi networks, and it’s best to drag most-used ones to the top, to avoid your Mac wasting time first
searching for the others when trying to connect. You can select and delete any you no longer need
• TCP/IP This is the protocol used to connect your Mac to the internet. Generally, connections will be automatic. However, if you’ve been
provided IP, subnet mask and router details to manually input.
• DNS DNS is how computers associate domain names with numerical IP addresses. Some people prefer to override default DNS settings
with the likes of Google Public DNS (8.8.8.8 and 8.8.4.4), which can under some circumstances be faster
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Bluetooth
The Bluetooth pane is used for controlling any Bluetooth devices your Mac is paired with. Using the button under the Bluetooth logo, you can
turn Bluetooth on your Mac on and off. Your Mac’s name is displayed under the button.

Devices This Panel shows your devices that are in discovery mode devices or devices that are paired with the computer and their current status.
Hover the cursor over an item and a cross button appears, which when clicked removes the item from the list. Note that if you remove an item
and then want to use it later, you’ll need to pair it again with your Mac.
Show Bluetooth in menu bar This menu extra provides a faster means of turning Bluetooth on and off, along with enabling you to connect/
disconnect hardware and ascertain its battery level. It can also be used to send files to connected devices and browse files already on them.
Advanced This provides a few further options:
• Open Bluetooth Setup Assistant at startup if no keyboard is detected at startup
• Open Bluetooth Setup Assistant at startup if no mouse or trackpad is detected at startup
• Allow Bluetooth devices to wake this computer
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Extensions
Use Extensions preferences to enable and disable Apple and third-party Mac extensions. Mac extensions, such as Markup, add extra functionality
to apps or to the Finder. In Extensions preferences, you can also select the items that you want to see in the Share menu, and select widgets you
want to see in Today view in Notification Center.

All Extensions you installed on your Mac. These are extensions created by third-party developers. If the extension is a content extension that
enables extra functionality in apps, you see an Actions checkbox below the extension. If it’s a Finder extension, you see a Finder checkbox. Select
the checkbox to enable the extension.
Actions Content extensions installed on your Mac. Select a content extension to make it available in apps. For example, if Markup is selected, you
can draw on pictures and sign documents in apps such as Mail, TextEdit, or Preview.
Finder (available only if you have Finder extensions installed) Select extensions that you want to access from the Quick Actions shortcut menu
on the desktop and in the Finder, and in the Finder preview pane. See Perform quick actions in the Finder.
Photos (available only if installed) Photos extensions installed on your Mac, such as Markup. Select a Photos extension to make it available in
Photos while editing photos.
Share Menu Select the items that you want in the Share menu.
• Default extensions, such as Mail, Messages, and AirDrop, cannot be deselected.
• If an extension selected in the list doesn’t appear in the Share menu, the item you’re trying to share can’t be shared using that extension.
For example, you can use AirDrop to share a webpage in Safari, but not selected text.
Today Select widgets, such as Find My Friends, to show in Today view in Notification Center. You can also show or hide widgets right in
Today view.
Touch Bar Select extensions that you want to access from the Touch Bar, if you set options for the Touch Bar to show Quick Actions or added the
Quick Actions button to the Touch Bar.
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Sharing
The Sharing pane opens up various aspects of your Mac to other computers on the network. The top of the pane shows the computer’s name,
which is editable, and the left-hand section lists services available for sharing.

Screen Sharing This enables the Mac’s screen to be shared. The ‘Allow access for’ section of the main pane provides control over who can access
the shared screen: all users, or specified users and groups, added or removed using the Add (+) and Remove (–) buttons. The ‘Computer Settings’
button provides access to allow anyone to request access, and to allow VNC users control with a specified password.
File Sharing This activates a Mac’s Public Folder, which has a Drop Box into which anyone on the network can drop files. The ‘Options…’ button
in the System Preferences pane opens a sheet with settings for activating or deactivating connection types, and the ‘Shared Folders’ and ‘Users’
panels, respectively, optionally enable you to share additional folders and provide various access types to specific users or groups.
Printer Sharing This provides the means for sharing a connected printer across the network.
Remote Login This enables someone to log in to the Mac from another computer on the network, using SSH and SFTP.
Remote Management This works with Apple Remote Desktop, and is designed for people having to manage a network of Macs.
Remote Apple Events This allows applications on other Macs to send Apple events to it. An event is a task being performed on a Mac, such as
opening a document or printing. So with this option activated, an AppleScript running on another Mac on the network could potentially open
and print a document on your Mac.
Internet Sharing You can share your Internet connection with other users on your local network.
Bluetooth Sharing The Mac can share files with other Bluetooth enabled devices. The first two menus determine what happens when files are
received (Accept and Save, Accept and Open, Ask What to Do, or Never Allow), and where accepted items are saved. The second set of menus
determines what happens when other Bluetooth devices browse the Mac. You can choose from Always Allow, Ask What to Do and Never Allow,
along with selecting a folder others can browse.
Content Caching Content Caching speeds up the downloading of software distributed by Apple and of data in users’ iCloud accounts by caching
content that local Mac computers, iOS devices, and Apple TV devices have already downloaded. Content Caching can be used on networks
consisting of a NAT environment for the content cache and all devices, or it can be used on networks consisting of publicly routable IP addresses.
Apple devices running iOS 7 or later and OS X v10.8.2 or later automatically contact a nearby caching server without any configuration.
Important: It’s strongly recommended that Content Caching be deployed on a Mac that has a single wired Ethernet connection as its only
attachment to the network. Content Caching can use a Wi-Fi connection instead of Ethernet, but performance might be worse.
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Users & Groups
If your Mac has multiple users, you should set up an account for each person so he or she can personalize settings and options without affecting
other users.

User picture Click the picture to edit it, then select a new picture.
• Use a picture included with macOS: Click Defaults, then select a picture.
• Take your picture using your Mac: Click Camera; when you’re ready, click Take Photo.
• Use a picture from the Photos app: Click Photos. To see specific photos from a time, place, or album, click a disclosure triangle below
photos, then select a group of photos. Select a picture, then click Next.
• Use a picture from the Photo Booth app: Click Photo Booth to see pictures you’ve taken using your Mac and the Photo Booth app. Select
a picture, then click Next.
Instead of clicking the picture, you can drag and drop an image file from the Finder onto the picture.
Change/Reset Password Click the button to change the login password and password hint. To use the Password Assistant, click the key next to
the Password field.
Contacts Card Click Open to view and edit your Contacts card. Only available for the user who is currently logged in.
Allow user to reset password using Apple ID Lets the user change their password for this Mac at login by entering their Apple ID and password.
To use this option, the user must have set up iCloud on this Mac. However, this option isn’t available if FileVault is turned on and set to allow the
user to reset their password at startup using their iCloud account.
Allow user to administer this computer Makes the user an administrator for this Mac.
Enable parental controls Lets you manage a user with parental controls. To set restrictions, click Open Parental Controls.
Add (+) and Remove(–) Buttons To add a new user or group, click the Add (+) button, then enter the information for the new user or group. To
delete a user or group, select it in the list, then click the Remove (–) button.
Types of Users
Administrator An administrator can add and manage other users, install apps, and change settings. The new user you create when you first
set up your Mac is an administrator. Your Mac can have multiple administrators. You can create new ones, and convert standard users to
administrators.
Standard Standard users are set up by an administrator. A standard user can install apps and change settings for his or her own use. Standard
users can’t add other users or change other users’ settings.
Managed with Parental Controls Users who are managed with parental controls can access only the apps and content specified by the
administrator managing the user. The administrator can restrict the user’s contacts and website access, and place time limits on computer use.
Sharing Only Sharing-only users can access shared files remotely, but can’t log in to or change settings on the computer. To give the user
permission to access your shared files or screen, you may need to change settings in the File Sharing, Screen Sharing, or Remote Management
panes of Sharing preferences.
Group A group allows multiple users to have the same access privileges. For example, you can grant a group specific access privileges for a folder
or a file, and all members of the group have access. You can also assign a group specific access privileges for each of your shared folders. You
control a group’s access to your shared folders by setting access permissions in the File Sharing section of Sharing preferences.
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If you’re an administrator of your Mac, you can use the Login Options pane of Users & Groups System Preferences to customize how users log in
to your Mac.
Automatic login Choose Off to require users to log in whenever the Mac restarts. To automatically log in a particular user when the Mac restarts,
choose the user’s account name and enter the user’s password. This option is useful if the Mac has only one user and is always in a secure
location. If security is a concern, automatic login should be off.
Note: If FileVault is turned on, automatic login is disabled..
Display login window as To let users choose from a list of user names when logging in so that they don’t have to remember their user names,
select “List of users.” To require users to enter both user name and password when logging in, select “Name and password.”
Show the Sleep, Restart, and Shut Down buttons Shows these buttons in the login window.
Show Input menu in login window Lets users choose the language macOS uses after login.
Show password hints Displays a password hint in the login window. The hint is shown during login if the user clicks the question mark in the
password field or enters a password incorrectly three times in a row.
Show fast user switching menu as Enable switching quickly between users from the menu bar. Choose how users are displayed in the menu bar
from the pop-up menu.
Use VoiceOver in the login window Allows VoiceOver, the screen reader built into macOS, to be used during login.
Allow network users to log in at login window Lets users log in to your Mac using accounts on a network account server that your Mac is
joined to.
Accessibility Options To select options that make it easier to log in to your Mac, click Accessibility Options.
Network Account Server To join (or connect) your Mac to a network account server, click the Join or Edit button. The button is labeled Join if your
Mac isn’t connected to a network account server. It’s labeled Edit if your Mac has an existing connection.
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Parental Controls
As a parent, you want your kids to have a safe and happy experience on the Mac. Using Parental Controls preferences, you can manage,
monitor, and control the time your kids spend on the Mac, the websites they visit, and the people they chat with. Use Parental Controls System
Preferences to turn on parental controls for children and to allow parental controls settings to be managed from another Mac.

Turn on parental controls When you open Parental Controls preferences, if you see the message “There are no user accounts to manage,”
you will need to add a managed user. A managed user is someone whose account you manage using parental controls. To make someone a
managed user, you can create a new user with parental controls enabled or convert an existing standard user account to a managed user.
1. Choose Apple menu > System Preferences, then click Users & Groups.
2. Click the lock icon to unlock it, then enter an administrator name and password.
3. Select a standard user in the list of users, then select “Enable parental controls.”
4. If the user isn’t in the list, click the Add (+) button to create a new user. Click the Age pop-up menu, then choose an age group. Fill in
the name, account, and password information, then click Create User.
Note: You can’t set up parental controls for administrators or sharing-only users.
If you want limited access for a user on the Mac, but don’t want to add that person as a user, set up a guest user account that you manage with
parental controls.
1. Users list To turn on parental
controls for a user, select the
user, then click Enable Parental
Controls. If a user already has
parental controls turned on,
select the user to view or change
settings.

❽

❶

2. Manage parental controls from
another Mac (not shown) Allow
the parental controls settings for
users on this Mac to be managed
from another Mac on the local
network. If you don’t see this
option, Command-click the
selected user so that no user is
selected.
3. Lock To make changes to Parental
Controls preferences, click the
lock icon to unlock it, then enter
an administrator name and
password.

❹ ❺❻

4. Add To add a user to manage with
parental controls, click the Add (+)
button.
5. Remove To remove a user
managed with parental controls,
select the user, then click the
Remove (–) button.

❼
❸

6. Action pop-up menu Use this menu to copy and paste parental controls settings, remove parental controls, and remotely manage
parental controls.
7. Logs Monitor a child’s use of the Mac. Click Logs to get information on the child’s app and Internet activities.
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8. Set restrictions Select a user, then click a button at the top:
Apps: Prevent the child from using the built-in camera and joining multiplayer games in Game Center. Restrict a child’s contact
with other people through Mail. Specify which apps the child can access.
Web: Limit access to websites, or allow unrestricted access.
Stores: Disable access to the iTunes Store and the iBooks Store. Limit a child’s access to music, movies, TV shows, apps, and
books to only those with age-appropriate ratings.
Time: Set time limits for weekdays, weekends, and bedtime.
Privacy: Allow the child to make changes related to privacy.
Other: Prevent the child from using Siri and Dictation, editing printer and scanner settings, and burning CDs and DVDs. Hide
profanity in the dictionary and other sources. Prevent the Dock from being modified. Provide a simplified view of the Mac
desktop.
Manage parental controls from another Mac After you set restrictions for a child on a Mac, you can manage parental controls from a
different Mac. Both computers must be on the same network.
1. If you don’t see this option, there may be a user selected on the left side of Parental Controls preferences. Command-click the
selected user so that no user is selected.
2. On the Mac you want to use to manage the child’s parental controls settings, choose Apple menu > System Preferences, then
click Parental Controls.
3. Click the lock icon to unlock it, then enter an administrator name and password.
4. Select the user to be managed.
5. You can now change the child’s parental controls settings and monitor the activity logs.
Reuse parental controls settings You can copy a user’s parental controls settings and apply them to another user.
1. Select the user whose settings you want to copy.
2. Click the Action pop-up menu , then choose Copy Settings.
3. Select the user to whom you want to apply the copied settings.
4. Click the Action pop-up menu , then choose Paste Settings.
Turn off parental controls
1. Choose Apple menu > System Preferences, then click Parental Controls.
2. Click the lock icon to unlock it, then enter an administrator name and password.
3. Select the user, click the Action pop-up menu , then choose Turn off Parental Controls.
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Siri
You can use Siri preferences to turn on Siri and choose a language and voice type.

Enable Ask Siri Use Siri to do everyday tasks, get quick answers, and more. To stop using Siri, deselect the checkbox. (Siri continues to learn
from and make suggestions in apps.) If you ask Siri something when the checkbox isn’t selected, you’re prompted to enable Siri. You must be
connected to the Internet to use Siri.
Listen for “Hey Siri” (available on some Mac models) Select the checkbox to be able to say “Hey Siri” to start using Siri, instead of clicking the Siri
icon or using a keyboard shortcut. To stop using Hey Siri, deselect the checkbox. If you turn off Ask Siri and then turn it on again later, you may
need to set up Hey Siri again.
Allow Siri when locked (available when Listen for “Hey Siri” is turned on) Use Siri even if your Mac is locked or in sleep. Just say “Hey Siri,” then
make your request. Depending on your request, you may need to unlock your Mac.
Keyboard Shortcut By default, to start using Siri, press and hold the Command key and the Space bar at the same time. If you want to set
your own shortcut to open Siri, click the pop-up menu, choose Customize, then press the keys you want to use. For example, you could press
Option-Z.
Language Choose the language and dialect that you want to use to ask Siri; Siri will use the same language and dialect to speak to you. Siri is
not available in all languages or regions.
Siri Voice Choose a gender (and sometimes dialect) for Siri. Some languages may not have an alternate gender or dialect.
Voice Feedback Turn voice feedback (spoken responses) from Siri on or off. If you turn feedback off, the response from Siri is shown in the Siri
window but is not spoken.
Show Siri in menu bar Show the Siri icon in the menu bar, to allow you to quickly open Siri.
Siri Suggestions & Privacy Choose the apps for which Siri can make suggestions to you. For information about how Siri sends your spoken words
to Apple and uses personal information such as your name, your contacts, and other data to understand you better and recognize what you say,
click About Siri & Privacy.
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Date & Time
Use Date & Time System Preferences to set the date and time on your Mac. You can have the date and time set automatically using a network
time server, or set your computer’s date and time manually. Be sure your time is correct so time stamps on emails, messages, and files are correct.

Date & Time
• Set the time automatically: Select “Set date and time automatically,” click the pop-up menu, then choose the server that’s closest to you, or type
the address of your network time server.
If your Mac isn’t connected to the Internet, it connects when you choose this option.
• Set the time manually: Deselect “Set date and time automatically.” Click today’s date on the calendar, drag the clock’s hands to show the correct
time (or enter the time), then click Save.
You can also use the up and down arrows next to the date or time field, or type over the current date or time.
Time Zone
• Set the time zone automatically: Select “Set time zone automatically using current location.”
• Set the time zone manually: Deselect “Set time zone automatically using current location,” click a location on the map, click the Closest City
pop-up menu, then choose the city closest to your location.
Clock
• Show date and time in menu bar: Select the checkbox to see the date and time in the top-right corner of the menu bar. In “Time options” and
“Date options,” set how you want the date and time to appear.
• Announce the time: Select the checkbox to hear the time announced, then choose when you want it announced. If you want, you can
customize the voice.
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Time Machine
Time Machine is the built-in backup feature of your Mac. To use it, you need an external storage solution, sold separately:
• External hard drive connected to a USB, FireWire, or Thunderbolt port on your Mac
• Time Capsule or macOS Server on your network
• External hard drive connected to the USB port of an AirPort Extreme base station on your network

Set up Time Machine When you connect an external hard drive directly to your Mac, you might be asked if you want to use the drive to back
up with Time Machine. Click “Use as Backup Disk.” If you select the option to encrypt, your backups will be accessible only to users with the
password.
1. Open Time Machine preferences from the Time Machine menu Time Machine icon in the menu bar or choose Apple menu () >
System Preferences, then click Time Machine.
2. Click Select Backup Disk, Select Disk, or Add or Remove Backup Disk.
3. Select a backup disk from the list, then click Use Disk.
4. For addtional backup security and convenience, you can repeat these steps to add another backup disk. For example, you might use one
backup disk while at home, and another backup disk while at work.
Back Up Automatically Select to have Time Machine automatically back up your files.
Select Backup Disk, Select Disk, Add or Remove Backup Disk If you haven’t set up Time Machine, click Select Backup Disk to set up a backup disk.
Repeat the steps for each backup disk you want to set up.
If you already set up Time Machine, your backup disks are listed, and information about each backup disk is shown. To select, add, or remove
backup disks, click Select Disk or Add or Remove Backup Disk.
Options Set options to exclude items from being backed up, back up while on battery power, and be notified after old backups are deleted.
Show Time Machine in menu bar Add a Time Machine menu to the menu bar along the top of your screen.
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Accessibility - General
Accessibility comes standard in a Mac. Whether you have difficulties with vision, hearing, or physical mobility, macOS includes a variety of
features to help you work in alternative ways—and make your Mac even easier to use. Use the General pane of Accessibility System Preferences
to select the options to include in the Accessibility Options shortcut panel.

The shortcut panel (shown when you press Option-Command-F5 or, if your Mac has a Touch Bar, when you quickly press Touch ID three times) is
a quick way to turn on or off the options you use most often.
List of options Select the checkboxes for the options you want to include in the Accessibility Options shortcut panel. If you don’t want to include
an option, deselect its checkbox.
If you select only one option, the shortcut panel isn’t displayed when you press Option-Command-F5 or press Touch ID three times; instead, the
option is immediately turned on or off.
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Accessibility - VoiceOver
Use the VoiceOver pane of Accessibility System Preferences to turn VoiceOver on or off, open VoiceOver Utility, or start the VoiceOver tutorial.

Enable VoiceOver Turn VoiceOver on or off.
Open VoiceOver Training Learn how to use VoiceOver.
Open VoiceOver Utility Customize VoiceOver settings.
You can also turn VoiceOver on or off using the Accessibility Options shortcut panel. To use the panel, press Option-Command-F5 (or if your
Mac has a Touch Bar, quickly press Touch ID three times).
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Accessibility - Zoom
Use the Zoom pane of Accessibility System Preferences to make items on the screen appear larger.

Use keyboard shortcuts to zoom Use the listed shortcuts to zoom in and out. For example, to zoom in, press Option-Command-Equal Sign.
When this option is selected, you can use the shortcuts on the login screen to make the password field appear larger.
Use scroll gesture with modifier keys to zoom Hold down the selected modifier key while scrolling with your trackpad or the scroll wheel on
your mouse. For example, with the default trackpad settings, press and hold the Control key and drag two fingers up (to zoom in) or down (to
zoom out).
Smooth images Make zoomed images appear smooth.
Zoom follows the keyboard focus Magnify the area that has the keyboard focus.
Enable Touch Bar zoom If your Mac has a Touch Bar, display a larger version of it on the screen.
Speak items under the mouse Have your Mac identify items under the pointer only when you use zoom or always. You can set whether to have
your Mac wait a shorter or longer time before speaking.
Zoom Style Show the magnified image on the entire display (Fullscreen) or in a window (Picture-in-picture).
Options Specify options for full-screen or picture-in-picture zoom.
To quickly enable or disable Zoom using the Accessibility Options shortcut panel, press Option-Command-F5 (or if your Mac has a Touch Bar,
quickly press Touch ID three times). You can enable keyboard shortcuts for some zoom options in the Accessibility section of the Shortcuts
pane of Keyboard preferences. To open the pane, choose Apple menu > System Preferences, click Keyboard, then click Shortcuts.
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Accessibility - Display
Use the Display pane of Accessibility System Preferences to make items on the screen easier to see and read, and to reduce motion on the
screen.

Invert colors Invert the colors on your display. For example, text appears in white on a black background. If you turn on Night Shift, “Invert colors”
is automatically disabled. To quickly turn “Invert colors” on or off using the Accessibility Options shortcut panel, press Option-Command-F5 (or if
your Mac has a Touch Bar, quickly press Touch ID three times).
You can enable keyboard shortcuts for inverting colors and changing the contrast in the Accessibility section of the Shortcuts pane of Keyboard
preferences. To open the pane, choose Apple menu > System Preferences, click Keyboard, then click Shortcuts
Use grayscale Remove colors from the screen.
Differentiate without color Use shapes, in addition to or instead of color, to convey status or information.
Reduce motion Stop or reduce the movement of elements on the screen; for example, when you open apps, switch between desktops, or open
and close Notification Center.
Increase contrast Increase the contrast of items on the screen (such as borders around buttons or boxes) without changing the contrast of the
screen itself.
Reduce transparency Replace the transparent effect used on some backgrounds in macOS with a darker background, to improve contrast and
readability.
Display contrast Increase the screen contrast.
Cursor size Increase the size of the pointer.
Shake mouse pointer to locate Quickly move your finger on the trackpad or quickly move the mouse to temporarily enlarge the pointer so you
can find it.
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Accessibility - Speech
Use the Speech pane of Accessibility System Preferences to customize the system voice, be notified when an alert or app needs your attention,
and set a shortcut to speak selected text.

System Voice Choose a voice to speak text and alerts.
Speaking Rate Set the speed at which text is spoken. Click the Play button to hear sample spoken text.
Enable announcements Have your Mac announce and speak alerts. To customize, click Options, then select a voice, the phrase you want to hear
(such as the app name or “Attention!”) before an alert is spoken, and how long your Mac waits before it speaks the alert.
Speak selected text when the key is pressed Have your Mac speak text that you selected when you press the specified key. To customize, click
Change Key, then press the key combination you want to use. (For example, press the Option and Tab keys together to change to Option+Tab.)

45

Accessibility - Descriptions
Use the Descriptions pane of Accessibility System Preferences to listen to a description of the visual content in movies, TV programs, and other
media, if available.

Play audio descriptions when available If available, automatically play the description of the visual content.
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Accessibility - Captions
Use the Captions pane of Accessibility System Preferences to control how subtitles are styled, and whether to use closed captions instead, when
they’re available.

Styles list The three default styles (Default, Classic, Large Text), and styles that you added. To edit the settings for a style you added, select the
style in the list, then click Edit.
Add (+) button/Remove (-) button Create a style or delete one that you added. A new style inherits the settings of the style that’s selected when
you click Add. If you like many of the settings of an existing style, select it before you click Add, then change just the settings you
don’t like.
Prefer closed captions and SDH If they’re available, use closed captions or SDH instead of standard subtitles for content played on your Mac.
Style settings Settings for a new style, or one you’re editing. To have your setting always used, deselect its “Allow video to override” checkbox. In
the bottom section, you can set the color and size to use for a specific font whenever it’s used in subtitles.
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Accessibility - Audio
Use the Speech pane of Accessibility System Preferences to customize the system voice, be notified when an alert or app needs your attention,
and set a shortcut to speak selected text.

Flash the screen when an alert sound occurs Make your screen flash when you receive an alert.
Test Screen Flash Demonstrate a screen flash.
Play stereo audio as mono Make your Mac play stereo audio tracks as mono audio in the left and right speakers or headphones.
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Accessibility - Dictation
Use the Dictation pane of Accessibility System Preferences to choose or create dictation commands to use with Enhanced Dictation. With
Enhanced Dictation, you can use dictation commands included in macOS, or commands that you create, to control your Mac and use apps. You
can also enable a dictation keyword phrase to help you use the commands, even when you’re not dictating text.

Dictation Commands Show the list of dictation commands you can use when Enhanced Dictation is on. If you enabled advanced dictation
commands, they are also shown.
Enable the dictation keyword phrase Say a keyword phrase to start dictating and use dictation commands even when you’re not dictating text.
Play sound when command is recognized Have your Mac play a sound to indicate that it recognized the dictation command you spoke.
Mute audio output while dictating Silence music, podcasts, videos or other audio playing on your Mac while you are dictating.
Dictation commands and advanced command options
Commands are grouped by action (Selection, Navigation, Editing, Formatting, and System). Use the search field to find a command
Commands list If you create your own dictation commands, they appear in the User section at the top of the list. A checkmark next to a
command indicates it can be used. If you don’t want to use a command, deselect its checkbox. Click a command in the list to show how to say it.
Preview area Click a command in the list to show how to say it. There may be multiple ways to say a command. For example, to make a selected
word bold, you can say “Bold that,” “Bold this,” or “Bold selection.”
Enable advanced commands Show additional navigation and system commands, as well as app and document commands at the bottom of the
list. Also enable the ability to create your own dictation commands.
Add (+) button/Remove (-) button Click the Add (+) button to create your own dictation command. To delete a command you created, select it in
the User section, then click the Remove (-) button.
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Accessibility - Siri
Use the Siri pane of Accessibility System Preferences to type your requests to Siri instead of speaking them. This feature can be useful if speech is
difficult or if you don’t want others to hear your Siri requests.

Enable Type to Siri Type your requests to Siri instead of speaking them. If a headset with a microphone is connected to your Mac, Siri will speak
your typed request. If you prefer to read responses from Siri in the Siri window instead of having Siri speak them, turn off voice feedback in Siri
preferences.
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Accessibility - Keyboard
Use the Keyboard pane of Accessibility System Preferences to enable and set options for Sticky Keys and Slow Keys.

Enable Sticky Keys Press a set of modifier keys as a sequence, instead of all at once. For example, you would enter the key combination OptionCommand-F5 by pressing the keys in sequence.
Enable Slow Keys Adjust the delay between when you press a key and when it’s activated.
Sticky Key Options
Press the Shift key five times to toggle Sticky Keys Use your keyboard to turn Sticky Keys on or off.
Beep when a modifier key is set Have your Mac make a sound when you press a modifier key.
Display pressed keys on screen Show symbols in the selected area on the screen for the modifier keys you press.
Slow Key Options
Use click key sounds Have keys make a sound when pressed. You hear a sound when you press a key, and a different sound when the key is
accepted.
Acceptance Delay Set the delay between when you press a key and when it’s accepted.
To quickly enable or disable Sticky Keys or Slow Keys using the Accessibility Options shortcut panel, press Option-Command-F5 (or if your Mac
has a Touch Bar, quickly press Touch ID three times).
Use Sticky Keys with Keyboard Viewer to create an onscreen keyboard that you can type on using a mouse, trackball, or other input device. For
information about Keyboard Viewer, see Use the Keyboard Viewer.
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Accessibility - Mouse & Trackpad
Use the Mouse & Trackpad pane of Accessibility System Preferences to make your mouse and trackpad easier to use. The options available
depend on the Mac you’re using.

Enable Mouse Keys Use the keyboard instead of the mouse to control your Mac. Click Options to customize Mouse Keys:
• Press the Option key five times to toggle Mouse Keys: Use your keyboard to turn Mouse Keys on and off.
• Ignore built-in trackpad when Mouse Keys is on: Disable the trackpad on your Mac when you use Mouse Keys.
• Initial Delay: Set how quickly the pointer starts moving when you press a key.
• Maximum Speed: Set the maximum speed at which the pointer moves.
Double-click speed Adjust the mouse or trackpad’s reaction time when you double-click an item.
Spring-loading delay Use the slider to specify how long an item has to be over a folder before the folder opens.
Ignore built-in trackpad when mouse or wireless trackpad is present Disable the built-in trackpad on your Mac when you use a mouse or wireless
trackpad. If you use a non-Apple mouse, the driver software that came with your mouse may prevent this option from working as expected. For
information, see the documentation for your mouse.
Trackpad options
Scrolling speed Adjust the speed at which you scroll through documents and windows using the trackpad.
Scrolling Select the checkbox to turn scrolling on or off. Click the pop-up menu, then choose an option to control what happens when you lift
your finger from the trackpad:
• with inertia: Scrolling comes to a gradual stop.
• without inertia: Scrolling stops immediately.
Enable dragging Select the checkbox to be able to drag items. To set dragging options, click the pop-up menu, then choose an option:
• without Drag Lock: Double-tap an item, then drag it without lifting your finger after the second tap; dragging stops immediately when you
lift your finger.
• with Drag Lock: Double-tap an item, then drag it without lifting your finger after the second tap; dragging continues when you lift your
finger, and stops only when you tap the trackpad once.
• three finger drag: Drag an item with three fingers; dragging stops immediately when you lift your fingers.
Mouse options
Scrolling speed Adjust the speed at which you scroll through documents and windows using the mouse.
Scrolling Select the checkbox to turn scrolling on or off. Click the pop-up menu, then choose an option to control what happens when you lift
your finger from the mouse:
• with inertia: Scrolling comes to a gradual stop.
• without inertia: Scrolling stops immediately.
This option is available when you use a mouse such as a Magic Mouse.
To quickly enable or disable Sticky Keys or Slow Keys using the Accessibility Options shortcut panel, press Option-Command-F5 (or if your Mac
has a Touch Bar, quickly press Touch ID three times).
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Accessibility - Switch Control - General
Use the General pane of Switch Control Accessibility System Preferences to enable Switch Control and open the Panel Editor.

Enable Switch Control Turn on Switch Control to display the Switch Control Home Panel. To turn Switch Control off, deselect the checkbox or
close the Switch Control Home Panel. If the Close (x) button isn’t shown in the upper left corner of the Home Panel, move the pointer to the
corner so the button appears.
Allow platform switching to control your computer Use another Apple device, such as iOS devices or Apple TV, that is already set up to work with
your switches to control your Mac, so you don’t have to also set up your Mac with the switches.
Your Mac and other devices must be on the same Wi-Fi network, and you must be signed in to iCloud using the same Apple ID on all the devices.
Hide panel after inactivity Hide the Switch Control menu after the specified period of inactivity, up to 60 seconds. To show the menu again, press
any switch. This option is useful when you don’t need the menu for awhile, as when watching a movie.
Open Panel Editor Create panels to add to Custom in the Switch Control Home Panel, or to share with others.
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Accessibility - Switch Control - Typing
Use the Typing pane of Switch Control Accessibility System Preferences to set options to help you type when you use Switch Control.

Insert and remove spaces automatically Let Switch Control manage spaces when you’re writing text. For example, it automatically corrects
spacing after a period or between sentences, based on context.
Capitalize sentences automatically Let Switch Control manage capitalization when you’re writing text. For example, it automatically capitalizes
letters after a period (end of sentence), based on context.
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Accessibility - Switch Control - Switches
Use the Switches pane of Switch Control Accessibility System Preferences to add and delete switches, assign actions to switches, and set options
for auto scanning.

Required Switch Control requires the Select Item switch. When auto scanning is on, Switch Control automatically moves to the next item as it
steps through a panel, group, or user interface.
Before you can turn off auto scanning, you must create a Move To Next Item switch; Switch Control moves it into the Required list when you turn
off auto scanning.
Optional Optional switches to use, regardless of whether auto scanning is on or off.
Add (+) button/Remove (-) button Add or remove an optional switch.
Action pop-up menu Change the name or action for a switch. To use a different switch for the action, click Reassign.
Auto scanning Switch Control automatically steps through, or scans, items in a panel, group, or user interface. This option is on by default. If you
want to turn off auto scanning, you must add a switch for moving to the next item.
Timing Set timing options for auto scanning:
• Hold before perform duration: The number of seconds, up to 10, that a switch must be pressed to be recognized.
• Ignore switch repeats: The number of seconds, up to 10, during which repeated pressing of a switch is ignored.
• This option is useful if you’re prone to accidentally pressing a switch multiple times.
• Hold before repeat duration: The number of seconds, up to 10, that a switch must be pressed to be recognized a second time.
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Accessibility - Switch Control - Navigation
Use the Navigation pane of Switch Control Accessibility System Preferences to set options for navigating with Switch Control.

While navigating Indicate when an item is highlighted during a scan by playing a sound, speaking the item, or both. To change the voice used,
choose Apple menu > System Preferences, click Accessibility, then click Speech.
Restart position The position from which to start when you rescan an item (such as a panel, group, or window).
Auto scanning after select By default, auto scanning is paused when you select an item; you must press the Select Item switch to resume auto
scanning. To have auto scanning automatically continue after you select an item, click the pop-up menu, then choose Resume.
When pointer reaches edge The action taken when the pointer reaches a boundary while scanning user interface.
Switch Control cursor size The thickness of the border of the Switch Control cursor when scanning user interface.
Pointer precision The precision with which you control the pointer when selecting an item on the screen.
• Low: When you press the Select Item switch, the blue line (for Move, Move & click, and Glide) or the pointer (for Rotate) stops.
• High: When you press the Select Item switch, the blue line or the pointer substantially slows down so you can select more accurately where
to stop it; when you press the switch again, it stops.
Loops The number of times, up to 10, that a panel, group, or window is scanned.
Timing Set timing options for navigation:
• Gliding & rotating cursor speed: The speed, from 0 (slowest) to 100 (fastest), at which the blocks, sector, and blue lines move across
the screen.
• Auto scanning interval in panels: The number of seconds, up to 25, it takes to step from one item to another in a panel.
• Auto scanning interval in interface: The number of seconds, up to 25, it takes to step from one item to another in user interface.
• Pause on first item: The number of seconds, up to 10, that auto scanning stays on the first item in a panel, group, or user interface.
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Profiles
Use Profiles System Preferences to install, view, or remove configuration profiles. If you haven’t installed any configuration profiles, Profiles
preferences isn’t available. Configuration profiles are files that standardize settings for Mac computers, iOS devices, and Apple TV. If you have a
system administrator, you may be asked to install a configuration profile to access your network, email, VPN, and other services.

Add (+) button/Remove (-) button Add or remove an Profiles from the list.
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CDs & DVDs (Optional)
If your Mac has a built-in optical drive, or if you connect an external optical drive, you can use CDs and DVDs to play music, watch movies, or
access files that were backed up on a disc.

Insert a CD or DVD
Important: Built-in optical drives and the Apple USB SuperDrive accept only standard 120-mm (about 4.72 inches) round CD and DVD discs. Do
not insert smaller or irregularly shaped discs, and do not insert a disc with anything hanging from it (for example, a cleaner disc).
Insert a disc into the optical drive, with the label facing up or toward you, until you feel the drive catches and pulls it in.
You must insert the disc nearly all the way in before the drive pulls it in.
Choose what happens when you insert a CD or DVD
You can choose what your computer does when you insert certain types of CD and DVD discs. For example, you can open photo editing
software whenever you insert a picture CD, or run an AppleScript script that backs up your important documents whenever you insert a blank
DVD.
1. Choose Apple menu > System Preferences, then click CDs & DVDs. (If you don’t have an optical drive built into or connected to your Mac,
CDs & DVDs preferences aren’t available.)
2. Use the pop-up menus to choose an action for the type of inserted discs.
Some apps can start processing an inserted disc immediately. For example, iTunes can immediately import songs from a music CD, and DVD
Player can immediately play a video. For more information, see the help that comes with the app you want to use with the CD or DVD.
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